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RA/MA8000, ESA/EMA12000
 Fibre Solution Software V8.5C for
 Windows 2000 Datacenter Server

Release Notes

This document summarizes features and characteristics of the Compaq
StorageWorksTM HSG80 Array Controller (Array Controller Software Version
8.5k) that supports the release of the RA/MA8000, ESA/EMA12000 Fibre
Solution Software V8.5C for Windows 2000 Datacenter Server kit.

These Release Notes provide information for the HSG80 Array Controller
Software (ACS) version 8.5k, not covered elsewhere in the documentation.
Individuals responsible for installing, configuring, and using the HSG80 array
controller should use this document.

NOTE:  Read this entire document before installing or upgrading the software.
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These release notes include the following sections:

■ Identifying Your ACS Software Revision Level

■ Hardware and Software Support

NOTE:  Refer to this section for updates to StorageWorks Command Console Software
(SWCC) revision levels.

■ New Features

■ Configuration Rules

■ ACS V8.5 Operating Constraints

■ Using the HSG80 Controller in a Modular Solution

■ StorageWorks Command Console (SWCC)

■ HSG80 Documentation Additions and Corrections

Release Package Contents
The RA/MA8000, ESA/EMA12000 Fibre Solution Software V8.5C for
Windows 2000 Datacenter Server kit consists of:

■ The HSG80 Solutions documentation set:

q Modular Array Configuration Guide EK-MACON-CA. A01

q Compaq StorageWorks Command Console V2.3 User Guide
AA-RFA2F-TE

q HSG80 Array Controller ACS Version 8.5 Configuration Guide
EK-HSG85-CG. B01

q HSG80 Array Controller ACS Version 8.5 CLI Reference Manual
EK-HSG85-RG. A01

q HSG80 Array Controller ACS Version 8.5 Maintenance and Service
Guide EK-HSG84-SV. C01

q Registration
RA7000/8000, ESA10000/12000 and MA8000/EMA12000
EK-RAESA-RC. G01
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q StorageWorks Warranty Package
Warranty Terms and Conditions EK-SHXSW-WC. C01
Warranty Terms and Conditions Addendum 3R-Q178A-3V. B01
158199-021

NOTE:  The Warranty book uses DIGITAL and DIGITAL terminology. A COMPAQ Warranty
booklet is not yet available. Please check with your COMPAQ service representative for
any questions on warranty items.

q HSG80 Customer Letter AV-RNAZA-TE

q Compaq StorageWorks RA/MA8000, ESA/EMA12000 Fibre
Solution Software V8.5C for Windows 2000 Datacenter Server
Installation Guide AA-RNATA-TE

■ Windows 2000 Datacenter Solution Storage CD-ROM

Intended Audience
This document is for customers who have purchased the RA8000, ESA12000,
MA8000, or EMA12000 Fibre Channel with an HSG80 controller, and for
Compaq Multivendor Customer Services personnel responsible for installing
and maintaining systems that include the HSG80 array controller.

Specific Notes for Windows 2000
The SWCC Agent in this CD-ROM does not support older Compaq RAID
Array devices that are identified as SWXRC-04 or SWXRC-05. If support is
required for these devices, download an updated SWCC Agent from the
Compaq Support website at http://www.compaq.com/support.

Windows 2000 can run Microsoft’s Cluster Server Software. Refer to
documents that come with Microsoft’s software kits for instructions on setting
up clusters.

There is no Hot Plug support for KGPSA adapters under Windows 2000 at this
time. (Check the Compaq Support web page for updates.)
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Windows 2000 Specific Notes
■ The Fibre Channel Setup Utility installs HS_service and HSXdisk

software components.

■ Windows 2000 supports 8 LUNs per port unless otherwise instructed.

■ Windows 2000 supports SCSI-2 and SCSI-3 modes. SCSI-2 is
recommend unless you have a specific Heterogeneous SAN
requirement. Refer to the Compaq StorageWorks RA/MA8000,
ESA/EMA12000 Fibre Solution Software V8.5C for Windows 2000
Datacenter Server Installation Guide that comes with this kit for more
information.

 In SCSI-3 mode, the HSG80 controller implements a device at LUN 0
called the Command Console LUN. It exists to facilitate
communications between the SWCC and the HSG80 controllers.
Windows 2000 Plug-and-Play will, during boot up, display a New
Device Found message for each instance of CCL LUN. Select Cancel
for each popup window.

 In SCSI-2 mode, the CCL LUN is implemented differently and will not
produce the same popup window. Consult the Installation Reference
Manual for more information about SWCC, CCL, and SCSI modes.

■ In some Fibre Channel switch configurations, disk devices that are
discovered as part of the Windows 2000 Plug-and-Play process display
an erroneous message in the Device Manager screen. However, data to
and from the drives is unaffected and work correctly. During subsequent
system reboots, these erroneous messages disappear as the disk to driver
status is correctly synchronized. It’s normal to see event log messages
from HS_service during certain routine procedures. These are a result of
SCSI bus resets that occur during HSG80 events like startups and
controller failovers. Some messages appear as warnings and some as
errors. As long as the message source is HS_service, you should let the
Proactive Services software handle the interpretation.

■ There are two situations where you may experience drive letter
remapping. This could affect access to data by program you may need to
run. The first situation is one where you replace one server with another.
The second is a situation in which you simply replace a KGPSA adapter
in one of your systems. During such a system or adapter changeover, be
sure to manually remap drives to drive letters using the Disk
Administrator. This will restore proper access to your data.



  5

■ If you replace a KGPSA adapter in a server, you will need to reinstall
the KGPSA driver and then rerun the Fibre Channel Setup Utility. The
reason for this is that Windows 2000 may automatically reload the
original driver for this adapter and reset many of the important registry
settings. Follow the instruction in the Installation Reference Manual and
use the software in your CD-ROM for this.

■ We recommend that you load software directly from the CD-ROM
when installing drivers and running the Fibre Channel Setup Utility.
You may experience problems on some systems is you first copy the
CD-ROM contents to a disk drive and install from it.

■ There is no support for booting from disks in a RA8000/ESA12000 or
MA8000/EMA12000 under Windows 2000 at this time. (Check the
Compaq Support web page for updates.)

■ There is no support for Compaq’s Secure Path products under Windows
2000 at this time. (Check the Compaq Support web page for updates.)

Visit our Web Site for the Latest
Information

Check the Compaq website for the latest drivers, technical tips, and
documentation for the HSG80 Array Controller at
http://www.compaq.com/support.

Follow the links to Storage and Open Vendor Storage.

IDENTIFYING YOUR ACS SOFTWARE
REVISION LEVEL

You can identify ACS Software Version 8.5 by entering the following
command at the CLI prompt:

SHOW THIS_CONTROLLER

The resulting display lists the software revision level as one of the following:

V8.5K-0

V8.5Q-0

V8.5R-0
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HARDWARE AND SOFTWARE
SUPPORT

This section lists the hardware and software supported by ACS Version 8.5 for
Windows 2000 Datacenter Server platform kit release.

Required Driver Revision

HSxDISK.SYS is the driver required for all HSG80 Array Controller
configurations. The Solution Software CD-ROM included in the kit contains
the HSxDISK.SYS driver for Windows 2000. Install HSxDISK.SYS V5.4.8
for Windows 2000.

Operating System Support

ACS Version 8.5 on HSG80 controllers are used in conjunction Windows
2000.

StorageWorks Command Console (SWCC)

NOTE:  The SWCC User Guide is titled Compaq StorageWorks Command Console V2.3
User Guide. V2.3 here refers to the entire software suite revision.

SWCC, which is included in this release, is highly recommended. SWCC
provides a user interface that can be used to configure and monitor your
storage subsystem. Refer to the Compaq StorageWorks Command Console
V2.3 User Guide for information about installing and using SWCC.

Command Console Agent

The SWCC Agent in this CD-ROM does not support older Compaq RAID
Array devices that are identified as SWXRC-04 or SWXRC-05. If you require
support for such devices, you can download an updated SWCC Agent from the
Compaq Support website at http://www.compaq.com/support.
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Identifying Your SWCC Software
Revision Level

SWCC software suite for the HSG80 V8.5 consists of various components.
The following SWCC components are included in this release of the Solution
Software kit:

■ SWCC Command Console (storage window manager) V2.2.0.213

■ SWCC CLI Window V2.0.0.33

■ HSG80ACS85 StorageWindow V2.3.0.13

■ HSG80 StorageWindow V2.1.0.28

■ HSZ StorageWindow V2.3.0.47

■ HSZ80 StorageWindow V2.1.0.28

■ HSD StorageWindow V2.0.0.5

■ HSJ StorageWindow V2.0.0.5

In the above list, the name of each executable is given with its subfolder
relative to the installation folder of the SWCC Client kit.

Verification of the individual components can be done with Explorer by
right-clicking on the particular executable program in its folder and selecting
the Properties option. In the resulting Properties window, click on the Version
tab and select the Product Version to display the version of the program.

SWCC Manual Refresh Rate

Do not refresh SWCC windows more often than once every 30 seconds.

Storage Area Network (SAN)
Configuration

In a SAN configuration, only have one SWCC Agent active at one time.
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Host Adapter for Windows 2000 Datacenter
Server

The KGPSA-BC (380574-001) and KGPSA-CB (176479-B21) host adapter is
supported by Windows 2000 Datacenter Server operating system for HSG80
controllers operating with Intel Servers (see Table 1).

Table 1
Intel Server Adapter KGPSA-BC

Bus Operating
System
Version

Supported
Systems

Adapter
Firmware
Version

Driver
Version

PCI to

Fibre Channel

Windows 2000 X86 Based
Server

SF2.20X2 for
380574-001
SF3.00 for
176479-B21

4-4.4195
5-4.4195

If a KGPSA adapter is replaced in a server, the KGPSA driver will need to be
reinstalled and then the Fibre Channel Setup Utility will need to be rerun. The
reason for this is that Windows 2000 may automatically reload the original
driver for this adapter and reset many of the important registry settings. For
more information about installing the adapter refer to the Compaq
StorageWorks RA/MA8000, ESA/EMA12000 Fibre Solution Software V8.5C
for Windows 2000 Datacenter Server Installation Guide and use the software
in the CD-ROM that are part of this kit.

Load software directly from the CD-ROM when installing drivers and running
the Fibre Channel Setup Utility. You may experience problems on some
systems if you copy the CD-ROM contents to a disk drive and install from it.

NOTE:  The required adapter firmware and installation procedure are included on the
RA8000/ESA12000 or MA8000/EMA12000 solution software CD-ROM (P/N AG-RFAAC-BE)
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Device Support

ACS Software Version 8.5 supports the devices listed in Table 2 at the
indicated hardware and microcode levels.

Table 2
Supported Disk Drives

Device

Capacity
 in

Gigabytes

Spindle
Speed
(RPM)

Minimum
Microcode
Version

Minimum
Hardware
Version

DS-RZ1CB-VW 4.3 7,200 LYJ0 or 0656 A01

DS-RZ1CD-VW 4.3 10,000 0306 A01

DS-RZ1DB-VW 9.1 7,200 LYJ0 or 0307 A01

DS-RZ1DF-VW 380595-B21 9.1 7,200 N1H1, 0372, or 1614 A01

DS-RZ1DD-VW 380588-B21 9.1 10,000 0306 A01

DS-RZ1EF-VW 380694-B21 18.2 7,200 N1H1 or 0372 A01

DS-RZ1ED-VW 380589-B21 18 10,000 0306 A01

DS-RZ1DA-VW 147497-001 9 7,200 3B05 A01

DS-RZ1EA-VW 147598-001 18 7,200 3B05 A01

DS-RZ1FB-VW 147599-001 36 7,200 3B06 A01

123065-B22   BB00911CA0 9.1 7,200 3B05 A01

388144-B22   BB01811C9C 18.2 7,200 3B05 A01

128418-B22   BD018122C9 18.2 10,000 B016 A01

328939-B22   BD009122BA 9.1 10,000 3B07 A01

Fibre Channel Switch Topology Tip

If you see a constantly blinking light on your Fibre Channel Switch, it’s
possible that the topology setting is set to loop mode in your server. To correct
this, rerun the Fibre Channel Setup Utility.
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NEW FEATURES
This section briefly describes new features that have been added to the HSG80
ACS firmware since ACS V8.4. For more information on these features, see
the HSG80 Array Controller ACS Version 8.5 Configuration Guide.

External Cache Battery

Replace the External Cache Battery (ECB) every two years to prevent battery
failure.

If you shut down your controller for longer than one day, complete the
additional steps in “Shutting Down the Subsystem for an Extended Time” in
HSG80 Array Controller ACS Version 8.5 Maintenance and Service Guide.
This will prevent the ECB from discharging during planned power outages.

CLI Commands

Add connections and set connections now support the following Operating
Systems:

■ Compaq Tru64_UNIX

■ IBM

■ SNI

■ VMS

■ WINNT

■ SGI

■ HP

■ NOVELL NETWARE

CLI commands that were modified in all versions of V8.5 are:

■ SET EMU

■ CREATE_PARTITION

■ ADD REMOTE_COPY_SETS

■ ADD CONNECTIONS

■ SET connection-name
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Data Replication Manager

Data Replication Manager (DRM) provides controller-based mirroring across
a Fibre Channel link. Two HSG80 Subsystems are used on a host-port-to host-
port basis, allowing data to be synchronously migrated from one storage
subsystem or physical site to another.

In DRM configurations, the controllers are not only able to distribute an
Input/Output (I/O) request to both the initiator and target sites, but they can
transfer the initiator’s role to the target as needed. Thus, Data Replication
Manager is a distributed computing model that supports full Disaster Tolerant
storage.

For more information on Data Replication Manager, see the Data Replication
Manager HSG80 ACS Version 8.5P Operations Guide.

NOTE:  Data Replication Manager (DRM) requires ACS 8.5P.

DRM Asynchronous Mode

In asynchronous mode, the write operation is reported as complete to the host
before the data is written to the remote units of the remote copy set.
Asynchronous mode gives greater performance and faster response time, but
the data on all members of the remote copy set cannot be assumed to be
always consistent.

Write History Logging

Write history logging is a term to describe using a log unit to log a history of
write commands and data from the host when the target is inaccessible or to
synchronize the initiator site data during a planned failover.

■ Mini-merge—If the target becomes inaccessible, the writes that would
have gone to the target are logged to the association sets assigned log
unit. An inaccessible target in this context refers to links or target
controllers going down. When the target becomes accessible, a full copy
is not necessary. Only those host writes while the links were down are
re-issued. This is referred to as a mini-merge. If a full copy was in
progress at the time of the disconnect, write history logging is not
initiated and the full copy is restarted when the target is accessible
again.
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■ Fast-failback—During a planned failover, if write history logging has
been enabled at the target site, then when the failback is performed, the
initiator site is synchronized through a process called fast-failback. The
writes that would have gone to the initiator are logged to the
associations set’s log unit. Only those writes since the failover are re-
issued. A full copy is not necessary.

Dynamic Volume Expansion

Dynamic Volume Expansion creates a specialized volume, called a concatset
(short for concatenation set), from a storageset that has been given a unit
number. Another storageset can then be added to the concatset by the SET
concatset command.

Increase Host Connection

The maximum number of host connections has been increased from 32 to 64
for the table of known connections. This table is maintained in the controller’s
memory. If the table contains 64 entries, new connections cannot be added
unless some old ones are deleted.

Snapshot

A snapshot unit is one that reflects the contents of another unit at a particular
point in time (the instant the ADD SNAPSHOT_UNITS command is entered).
The snapshot unit can be presented to the host. The snapshot unit remains until
it is deleted (DELETE command).

In support of the snapshot functionality, when running the ACS V85S
firmware, it is strongly recommended that cache modules containing 512MB
of memory be used.

NOTE:  Snapshot functionality requires either ACS 8.5S or ACS 8.5P. It is STRONGLY
recommended that cache modules containing 512MB of memory be used.
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CONFIGURATION RULES
The following list outlines the configuration rules for the controller:

■ Maximum 127 visible LUNs and one Command Console LUN (CCL)

■ Maximum 512-GB LUN capacity

■ Maximum 72 physical devices

■ Maximum 20 RAID-5 storagesets

■ Maximum 30 RAID-5 and RAID-1 storagesets

■ Maximum 45 RAID-5, RAID-1, and RAID-0 storagesets

■ Maximum 8 partitions of a storageset or individual disk

■ Maximum 6 members per RAID 1 (mirrorset)

■ Maximum 14 members per RAID-5 storageset

■ Maximum 24 members per RAID 0 (stripeset)

■ Maximum 48 physical devices per striped mirrorset

ACS V8.5 OPERATING CONSTRAINTS
This section describes the operating constraints for ACS Software Version 8.5.
An operating constraint is a limitation placed on the operation of the
controller. Keep these constraints in mind to avoid problems and to help
achieve the maximum performance from your controller. Other constraints on
host adapters or other system components may also apply. See the host
documentation for more details.

Avoiding Problem Situations

Under certain conditions, you may experience unusual array controller
behavior. This section presents information to help you avoid such situations
and to recover from them if they occur.
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Adding, Moving, and Changing Devices

The array controller maintains a configuration map of a device’s type and
location. This map is used to communicate with devices. If you add, move, or
change a device while the array controller is powered off without first
changing the array controller configuration, the array controller is not able to
communicate with the changed device when it returns to service.

If a device is removed by mistake while the array controller is off, delete all
containers associated with the removed device after power has been restored to
the array controller.

If a device is replaced while the array controller is off, remove the device
before restoring power to the array controller. Correctly remove the current
device and add the new device after restoring power to the array controller.

Moving Storagesets

Move only normal storagesets. Do not move storagesets that are reconstructing
or have been reduced, or data corruption will result.

Adding, Moving, and Changing Array
Controllers, Cache Modules, or External
Cache Batter Storage Building Blocks

It is permissible to replace the array controller, cache module, or external
cache battery (ECB) Storage Building Blocks (SBB) while the subsystem is
shut down, However, you must enter the SHUTDOWN
THIS_CONTROLLER command before shutting the subsystem down to make
configuration changes. If two array controllers are configured in a dual-
redundant configuration, you must first enter the SHUTDOWN
OTHER_CONTROLLER command.

These commands instruct the array controllers to flush all unwritten data from
the cache modules and discontinue all I/O activity. For more information
regarding the SET controller command, see the HSG80 Array Controller ACS
Version 8.5 CLI Reference Manual. For information on maintenance and
replacement of the array controller, cache module, and external cache battery,
see the HSG80 Array Controller ACS Version 8.5 Maintenance and Service
Guide.
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Boot Support

Booting from the RA8000/ESA12000 and MA8000/EMA12000 is supported
for Windows 2000 using the KGPSA-CB adapter only. Look for application
notes or web pages in the support section of the Compaq web site.

Disk Geometry Limitations

Table 3 lists known limitations that certain operating systems have regarding
storage unit size.

Table 3
Operating System Storage Unit Limitation for RA2000/ESA12000 Only

Disk Size Storageset Configuration Operating System and Version

4 GB Any Windows 2000 FAT File System

16 Terabytes Any Windows 2000 NTFS File System

PVA Switch Setting

After installing the EMU in each cabinet, ensure that the SCSI ID number on
the PVA is set (see Table 4.)

Table 4
SCSI ID Number on the PVA

Cabinet PVA SCSI ID Setting

Master enclosure 0

First expansion enclosure 2

Second expansion enclosure 3
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5FRUTIL Limitation

NOTE:  FRUTIL cannot be run in remote copy set environments on the target side
specifically when I/O is in progress.

If the host load is quiesced, you can run FRUTIL on the initiator or target. If
the host load is not quiesced and FRUTIL is run while remote copy I/Os are
running, the normalization process will reset.

USING THE HSG80 CONTROLLER IN
A MODULAR SOLUTION

The modular solution consists of the HSG80 controller (single or dual
configurations) installed in a Model 2200 UltraSCSI Enclosure and the drives
installed in either a Model 4214R disk enclosure or a Model 4254 disk
enclosure. The modular solutions must be mounted in RETMA cabinets. The
RETMA cabinets are available in heights of 42U, 41U, 36U and 22U. The
Model 2200 enclosure is 4U. The Model 4214R disk enclosure and the Model
4254 disk enclosure are each 3U. This combination allows for several cabinet
configurations.

NOTE:  If you are using an existing HSG80 controller, it will require the Cache Bulkhead
upgrade for installation of the HSG80 in the Model 2200.

■ For information about how to install the HSG80 controller in a Model
2200 UltraSCSI Enclosure, see the Compaq StorageWorks Model 2200-
series Enclosure User Guide.

■ For information about how to install drives in either a Model 4214 disk
enclosure or a Model 4254 disk enclosure, see the Compaq
StorageWorks Enclosure 4200 Family LVD Disk Enclosure User Guide.

■ For information about the 9000-series, see the Compaq 9000 Series
Rack Products Reference Guide.

Disk Enclosures

The HSG80 controller firmware can address up to 12 disks per SCSI bus. In
single bus mode, this means that 12 of the 14 disks in models 4214R and 4254
are used. The 2 extra disks can be used for in-cab inventory. The firmware can
see seven disks on each bus allowing use of all 14 when configured for dual-
bus mode. The maximum number of disks supported by an HSG80 (single or
cooperating pair) is 72. The disk enclosures can be configured for single bus or
for dual bus.



  17

NOTE:  The 42xx disk enclosures do not allow daisy chaining between shelves

Single-Bus Mode

Table 5 lists the disk enclosures options with single bus mode.

Table 5
Single Bus Mode

Disk Enclosures Options/Single Bus Mode Part Number

StorageWorks Enclosure Model 4214 R
(Rack Mountable Single Bus Single Power 14 Bay Drive Shelf)

103381-001, B31, 291

Second Power Supply for 4214R
(Adds a redundant power supply to the 4214R)

119826-B21

Dual Bus I/O Module for Existing 4214R
(Changes the 4214R from a single bus to a dual bus)

119829-B21

Note:  4214Rs shipped before February 28, 2000, may require the exchange of the EMU
and single bus modules to operate properly with the HSG80. Check the EMU and I/O
modules: if you see a “FB” sticker, the modules are appropriate for the HSG80. If there is
no sticker, contact your local service representative.

Dual-Bus Mode

Table 6 lists the disk enclosures options with dual bus mode.

Table 6
Dual Bus Mode

Disk Enclosures Options/Dual Bus Mode Part Number

StorageWorks Enclosure Model 4254
(The 4254 includes the redundant power supply and the dual
bus I/O module.)

138151-001, B31, 291

Note:  There is no option available to transform a Model 4254 disk enclosure to single bus.
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SCSI Cables

SCSI Cables are required to be ordered separately for connection to the Model
2200 enclosure.

NOTE:  At the time of this release, only the 1-meter SCSI cable (168256-B21) has been
FCC qualified and is supported.

Table 7 lists the available SCSI cables for dual bus mode.

Table 7
SCSI Cables

SCSI Cable Options/Dual Bus Mode Part Number

1M SCSI Cable 168256-B21

2M SCSI Cable 168258-B21

3M SCSI Cable 189505-B21

5M SCSI Cable 400983-005

10M SCSI Cable 400983-010

Modular Solution

The Modular Array/Enterprise Modular Array storage systems can be ordered
three ways.

■ Predefined models are available that provide a set number of controller
shelves and drive shelves in a Modular Storage Cabinet:

q MA8000: One Model 2200 controller enclosure and three dual-bus
Model 4254 disk enclosures in a 22U Modular Storage Cabinet

q EMA12000 D14: Three Model 2200 controller enclosure and nine
dual-bus Model 4254 disk enclosures in a 42U Modular Storage
Cabinet

q EMA12000 S14: One Model 2200 controller enclosure and six
single-bus Model 4214R disk enclosures in a 36U Modular Storage
Cabinet

q EMA12000 Blue: One Model 2200 controller enclosure and three
dual-bus Model 4254 disk enclosures in a 41U Modular Storage
Cabinet
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NOTE:  The  predefined models require the following options: Controllers, Controller
firmware, and drives.

■ Configure-to-Order. This allows you to specify the number of controller
shelves and drive shelves desired in a Modular Storage Cabinet.

■ Assembly on site. This allows you to order the components separately
and install them in any supported RETMA rack or cabinet.

StorageWorks Command Console
This portion of the release notes provides application information on Version
2.3 of the Command Console HSG80 Client software suite. Command
Console Client, HSG80 Storage Window 2.3 is a feature-rich graphical user
interface (GUI) for StorageWorks HSG80, Fibre Channel controllers.

NOTE:  Logical View is an accurate representation of your subsystem; however, the
physical view may not be an accurate representation of your subsystem.

If you plan to use the SWCC with a Fibre Channel switch and the HSG80
controller, first install the SWCC that came with the switch and then install the
SWCC that came with the HSG80 controller.

This section of the release notes covers the Command Console Storage
Manager and CLI Window modules. These modules are referred to within as
“Client.”

Document Issues

The term “Command Console” can refer to the Storage Window Manager. It
can also refer to the entire Command Console product suite and all of its
components, or simply as “the software.”

In this section, Storage Window Manager, paging, and automatic event
notification issues are presented to cover situations that Command Console
Clients have been installed under an installation that includes a Storage
Window Manager.

Client and Agent are intimately connected in their operation. Although these
release notes are meant to cover Client issues, some Agent-specific issues are
included for completeness.
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More Information

For complete product information on Command Console, see the product’s on-
line Help. Also, for details on the features of the controller software, see the
controller documentation.

Installation Notes

Be careful about the order in which you install certain SWCC products. If you
install SWCC from a Switch CD-ROM kit, it may overwrite newer SWCC
components that have been installed with the CD-ROM that ships with this kit.
You should reinstall using the CD-ROM in this kit to ensure that you have the
latest client versions.

Stand-Alone Installations

After doing a stand-alone install of a device-specific Client, exit Command
Console before adding or accessing a system with that type of device.
Command Console will then recognize the installation

SWCC 1.1B Client Will Not Work if
Version 2.x Client Was Already Installed

SWCC 1.1b will not work properly if you already have SWCC 2.x on a
Windows 2000 operating system. The Asynchronous Event Service that comes
with SWCC 2.x uses the same port as SWCC 1.1b. SWCC 1.1b can be
removed without impacting SWCC or ServerWORKS.

To remove SWCC version 1.1b perform the following steps:

 1. Uninstall SWCC 1.1b. Ignore the error box that appears.

 2. Reboot the computer. The integration for SWCC 1.1b will have been
removed.

 3. Integrate SWCC 2.x with ServerWORKS.
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"There is no disk in the drive" Message

When you install the Command Console Client, the software checks the
shortcuts on the desktop and in the Start menu. In Windows 2000, the
installation will check the shortcuts of all users for that computer, even if they
are not currently logged on. You may receive an error message if any of these
shortcuts point to empty floppy drives, empty CD-ROM drives, or removable
disks that are no longer present. Do the following:

■ Ignore the error message by clicking Ignore.

■ Replace the removable disks, and place a disk in the floppy drive and a
CD-ROM in the CD-ROM drive. Then, click Retry.

Uninstall Notes

Command Console Client Uninstall Does
Not Remove AsyncEventService Entries

Before uninstalling the Command Console Client, first remove the
AsyncEventService entries. This prevents the computer from sending you
messages during boot time about a service failing to start.

Under Windows 2000, change to the directory to which you installed the
Command Console Client, enter the following command:

AsyncEventService -remove

Then, remove the Command Console Client.

Clarifications

This section presents clarifications on the behavior of the software in certain
situations.

SWCC provides generic physical views of modular storage components
(MA8000, MA12000). These views may not exactly match the actual
configuration that you have. Take care in interpreting the shelf position in the
physical view when determining your actual shelf location.
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Integration Problems with SWCC and
Insight Manager

Starting with Insight Manager version 4.23, the HSG80 controller can be
monitored and managed from Insight Manager. Insight Manager includes the
HSG80 controller and its status on the Insight Manager storage display. Insight
Manager can also launch the SWCC HSG80 Storage Window to manage
storage connected to the HSG80 controller.

When the HSG80 Storage Window is opened within Insight Manager, the
Storage Window that supports ACS version 8.4 and earlier is launched. The
Storage Window will work correctly as long as it is used with HSG80
controllers that have ACS 8.4 or earlier. The HSG80 Storage Window that
opens within Insight Manager may not support ACS 8.5 or later.

A software “shim” is included with your solution software kit and should
install automatically on your client station. This “shim” provides access to the
HSG80 ACS 85 storage window from Insight Manager.

SWCC Agent Uninstall

The Windows 2000 SWCC Agent may not be completely uninstalled (that is,
the service is not removed) until a system reboots.

Duplicate Client Entries

Duplicate client entries may appear in the Windows 2000 Start menu. The
extra shortcuts can be removed as follows:

 1. Click Start > Settings > Taskbar.

 2. Click Start Menu > Programs.

 3. Click Advanced.

 4. Click Program folder.

 5. Click Command Console folder.

Remove duplicate entries manually from this folder.

EMU Status

The EMU status indicators do not reflect the proper status in modular storage
(MA8000, EMA120000). "CLI show EMU" gets "ERROR C000 EMU not
installed or operational" when it may be working correctly.
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Event Logs

The event log on a Windows 2000 client may have extra error message text
appended.

Cautions When Configuring from a
Configuration File

When reconfiguring a storage subsystem from a configuration file, the
program prompts you to choose whether the program initializes your virtual
disks. You must choose the appropriate option or you risk the loss of your data
as the configuration file is loaded and your subsystem is reconfigured.

■ Do not initialize virtual disks—Choose this option when your virtual
disks contain valuable user data, and you wish to retain that data. You
might, for instance, need to replace a failed subsystem component such
as a controller or cache module. In this case, your subsystem
configuration must be transferred to the new hardware, but you do not
wish to change any information on your storage devices themselves.

■ Initialize virtual disks—Choose this option when your virtual disks do
not contain user data, or when you do not care if the data on them is lost.
You might use this option when configuring a storage subsystem from
scratch, to make it match the configuration in your configuration file.

Virtual Disk Recovery from a
Configuration File

When you delete a virtual disk, the disk’s member drives are all reinitialized
and any user data is lost. You cannot restore the virtual disk’s data by
reconfiguring your subsystem from a configuration file. A configuration file
contains only information about the structure of a virtual disk and does not
contain the disk’s data itself.

Warning Message Windows

The controller software responds to problems in parsing and executing
commands from Client and Agent by returning a message window entitled
“Warning.” The content of such messages may contain such indications as
“Command Execution Error,” along with pertinent detailed information.

These messages are simply passed through for display by Client and Agent
and are normally associated with problems in the controller. However,
sometimes “Command Execution Error” does indicate a problem with SWCC.
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Virtual Disk Maximum Capacity

The maximum capacity of RAID-based virtual disks is determined by the
capacity of the smallest member, not the largest.

■ The maximum capacity of RAID 0 virtual disks is equal to the number
of members times the capacity of the smallest member.

■ The maximum capacity of RAID 1 virtual disks is equal to the capacity
of the smallest member.

■ The maximum capacity of RAID 0+1 virtual disks is equal to the
number of members in one stripe times the capacity of the smallest
mirrorset member.

■ The maximum capacity of RAID 3/5 virtual disks is equal to the number
of members minus one times the capacity of the smallest member.

Local Client/Agent Network Connection

To create a local connection to take advantage of Agent’s event notification
features, you can run both Client and Agent on the same Windows NT host
machine and connect them using a network connection. No special installation
instructions are necessary to implement this type of connection. Install each
component as if Client were to run on a system remote from the host machine.

NOTE:  Because the Client only runs on Windows NT and Windows 2000 systems, and

Agent runs on Windows NT, UNIX-based systems, and OpenVMS, you can only implement
this type of connection on a Windows NT system.

You cannot use Client with a local connection of either type while an Agent is running on
the local machine

Operating System Considerations

Client provides a graphical interface that replaces your controller’s CLI
interface. It cannot, however, perform all operating system configuration
necessary to make your subsystem’s virtual disks visible to the user in the
operating system.

When you create or delete virtual disks using either the CLI or Client, you are
adding or removing “disks” in the subsystem in a manner similar to plugging
or unplugging physical disk drives on the host bus. In either case, there are
certain operating system configuration actions you must perform to make these
“disks” visible or invisible to the operating system’s file system.
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Windows 2000 Configuration

On a Windows 2000 host, after you create or delete a virtual disk using Client
(or the CLI), you must perform the following steps to properly configure the
file system to recognize your changes.

 1. Boot the host system. This action has the effect of forcing the Disk
Administrator to recognize added virtual disks as raw disks, available
for use. It also notes that deleted virtual disks are no longer present.

 2. Create file system partitions on your disks. When you create a virtual
disk in the controller, you have the option to partition it at the controller
level in any way you wish, as long as you create at least one partition
per disk. Each of the controller-level partitions you create becomes a
virtual disk, visible to the host. In Disk Administrator, you must
partition these newly added virtual disks at NT’s file system (NTFS)
level.

 3. Once you have partitioned your drives in Windows 2000, the file system
assigns each drive a unique drive letter. Make a note of the drive letters
assigned.

 4. Format your disks—You must format each newly added disk.

 5. Start the Agent Configurator by double clicking its icon in the
Command Console Start Menu group.

 6. Navigate through the menus until a popup appears, prompting you to
rescan your subsystems. Click Yes to perform the rescan and display a
list of subsystems.

 7. Make sure that the access device you’ve been using for your subsystem
still exists. If you inadvertently deleted it, you must assign another
device in its place. If no access device exists, Client cannot
communicate with your subsystem unless the CCL is used.

 8. Click the Next button until you can exit the configurator.

 9. Select the Services option in the Windows Control Panel.

 10. Scroll down to highlight the Steam entry.

 11. Click the Stop button and wait for a prompt indicating that the service is halted.

 12. Click the Start button and wait for a prompt indicating that the service is started.

 13. Exit Control Panel.

 14. Windows 2000 now recognizes any changes you may have made in your
virtual disk configuration.
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UNIX-Based Configuration

On a UNIX-based host and after you create or delete a virtual disk using Client
(or the CLI), you must perform the following steps to properly configure the
UNIX file system to recognize your changes.

 1. Reboot the host system—This action has the effect of forcing the file
system to recognize added virtual disks as raw disks, available for use. It
also notes that deleted virtual disks are no longer present.

 2. (Optional) Create file system partitions on your disks—When you create
a virtual disk in the controller, you have the option to partition it at the
controller level in any way you wish. Each of the controller-level
partitions you create becomes a virtual disk, visible to the host.

 3. Afterward, if you desire, you can partition these newly added virtual
disks at UNIX’s file system level. Use the appropriate commands for
your operating system version to perform this task. Once you have
partitioned your drives in UNIX, the file system assigns each drive a
unique drive identifier.

 4. Stop and Restart the Agent—Using the Agent configuration script, you
must stop and restart the Agent running on your UNIX host, using the
configuration program. In the program, you must choose the option to
create a new storage.ini file. This action updates the Agent to recognize
any virtual disk changes you have made.

Enabling Subsystems in a Windows
2000 Agent Configurator

In the Step 3 dialogue box of the Agent Configurator, a check box entitled
“Subsystem Enabled” has been added. If this box is not checked, the program
configures the storage.ini file such that the subsystem selected in the dialogue
box is invisible to the host. If the box is checked, the subsystem is visible. The
default state for all subsystems is “enabled.”

Case Sensitivity in Client, Host, and
Storage Subsystem Names

In configuring Command Console for network operation, you must enter
names or IP addresses to identify your hosts, storage subsystems, and Client
systems. If you use names (as opposed to IP addresses), the names in Client
and Agent must be consistent to allow the programs to communicate with each
other. This section discusses issues of case sensitivity associated with name
entry in Client and Agent. This information does not apply when you use IP
addresses.
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In the connection dialogues in Client, you are required to enter host names,
and you have the option to enter specific storage subsystem names. In the
Agent installation and configuration programs, you are required to enter Client
and storage subsystem names.

Host and Subsystem Names in Client

Enter host and subsystem names in Client without regard to case.

Subsystem Names in Agent Installation/Configuration Programs

Enter subsystem names in the Agent installation/configuration programs
without regard to case.

Client Names in Agent Installation/Configuration Programs

For Windows 2000 and UNIX-based Agents, enter Client names in the
installation/configuration programs without regard to case.

ServerWORKS Connections

You can manually configure any Agent to send SNMP traps to a host running
Compaq Computer Corporation’s ServerWORKS by editing the client.ini file.
Edit the file to include the ServerWORKS host name and SNMP notification.

Running Client Via Network
Connections

You can operate Client over PPP, SLIP, or RAS network connections. Be
aware though, that some restrictions on features exist. See the Operating
Constraints section.

Display in VGA Mode

There are numerous issues involving the use of Client on a system with
standard, VGA resolution. The Storage window requires a minimum amount
of screen space to properly display its contents. When you use VGA display
resolution, screen space becomes more limited. It is highly recommended that
you use Client with a minimum of SVGA (800x600) display resolution.
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If you must use VGA resolution, consider the following suggestions:

■ You may not be able to see the scroll bars on the bottom of the display.
You can use the Storage window’s menu settings to remove the toolbar
from the display to make room for the bottom scroll bars.

■ If you are using Client with a 24-device, high-availability enclosure, it
may be easier to configure the subsystem if you set the system type to
Generic for configuration purposes. Return the setting to High-
Availability 24-Device Pedestal for monitoring and viewing.

Tuning Fault Notification

For faster fault notification, remove any unused host system names in the
client.ini file for each of your Agent programs. Inactive systems may force
timeouts that slow Client response to your commands.

Also, ensure that you are not using event notification while using RAS
connections. See “Delayed Event Notification on RAS Connections” in the
next section, for more details.

Paging and Event Logging Continues
After Client is Terminated

In certain situations, you may experience continuing paging and event logging
in response to subsystem faults, even though Client is not running. This
behavior is normal and is a result of paging and event logging activity started
by Client when it was running.

Client’s Asynchronous Event Service (AES) module runs as a Service, and
continues to run, even after Client itself has terminated. The AES module
communicates with Agents whenever it is running, and activates paging and
event logging when a subsystem event occurs.

In Windows 2000, to terminate paging and event logging after Client has been
closed, go to the Services section of Control Panel, select the
“AsyncEventSvc” Service, and stop it.

Setting Up Pager Notification

You may need to tune the pager notification feature for proper functioning
with certain pager systems. The pager feature supports both alphanumeric and
numeric pagers and allows for notification of multiple pagers. You can select
multiple pagers to be notified for multiple storage subsystems within different
blocks of time. You can also temporarily disable any pager.
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Use the following procedure to set up and tune the pager notification system:

 1. In Storage Window Manager, select Options > Event Notification >
User Profile.

 2. Click on New and enter the name of the person to be notified.

 3. Select the Pager folder and enter the person’s pager number, along with
any prefixes required to reach the outside telephone system. It is good
practice to place delays as commas (,) after any exchange switch that
might occur. Each comma results in two seconds of delay. An example
is: 8,,1, 800,5551212. In this example, there is a 4-second delay between
the 8 and the 1.

 4. Select the Alphanumeric box if the paging system supports it. Leaving
the box blank results in numeric paging only.

 5. Click on the Enabled box to enable paging to this person.

 6. Enter the start and end times that this person is available for paging. If
you want 24 hour coverage, enter a start time of 0:00 and an end time of
24:00. You must enter a time period for paging. Leaving the start and
end times at 0:00 has the effect of canceling paging for this person.

 7. Close the User Profile menu.

 8. Select Options/Event Notification/Notification List, to list all of the
persons to be notified as a named group. (Later, you will be able to
assign these groups to individual systems.) You can enter a description
along with the name to state such information as times and subsystems
that this person supports.

 9. If you’re using numeric paging, you can view the failure codes that are
used under Options>Event Notification>Pager codes.

 10. To set the communications port and baud rate for the pager modem,
select Options > Preferences to view the Event Notification Preferences
menu. You can also set the subsystem polling interval on this menu.

 11. You can establish paging on three separate levels: You can establish
paging on all levels on any combination of levels.

 a. My Enterprise—Notifies all notifications list listed here for problems
on all systems and subsystems

 b. Highlight “My Enterprise” in the Storage Window Manager and then
select File > Properties > Event Notification from the menu.
Clicking on the Notification List box will list all of the lists you have
created. Choice the list for persons that should be notified in case of
a failure on any system.

 c. System Level—Notifies all notifications lists listed here for
problems on the specific system and all its subsystems selected
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 12. Highlight the desired system name in the Storage Window Manager and
then select Start > Programs > File > Properties > Event Notification.
Clicking on the Notification List box will list all of the lists you have
created. Choice the list for persons that should be notified in case of a
failure on any subsystem of this specific system.

 13. Subsystem Level - Notifies all notifications lists listed here for problems
on the specific subsystem selected

 14. Highlight the desired subsystem name in the Storage Window Manager
and then select Start > Programs > File > Properties > Event
Notification. Clicking on the Notification List box will list all of the lists
you have created. Choose the list for persons that should be notified in
case of a failure on this specific subsystem.

 15. You have completed the paging notification setup. You may find that
you will have to make modifications in order to work with various
paging systems throughout the world.

Operating Parameters of Partition
Virtual disks

Keep in mind that virtual disks based on partitions on any container are all
closely related. They all share the same target and operating parameters of the
container. If you change any of this information for one partition on the
container, it automatically changes for all the partitions on that container.

Operating Constraints

This section describes the operating constraints for the software. An operating
constraint is a limitation placed on the operation of the controller by the nature
of its design. Keep these constraints in mind, to avoid problems and to help
you to get the maximum performance from your controller.

Compatibility Among Product Versions

CAUTION:  Pay particular attention to the instructions below for uninstalling
existing Client and Agent components from your local system. Failure to remove
existing components before installation may result in Windows Registry
corruption.

Version 2.1 software components are not compatible with version 1.1
components, and operation with mixed components is not supported. You
must uninstall your version 1.X software, including Clients and Agents, before
you install version 2.1 components. Use the instructions that came with your
version 1.x software to uninstall it.
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Before you install your new Client software, you must uninstall any existing
version 2.1 CLI Window. Use the “Add/Remove Programs” feature or the
instructions that came with your existing software to uninstall it. The
installation program will install a newer CLI Window version in your old
version’s place.

Note that, in configurations with existing version 2.x components, you need
not remove the Storage Window Manager components. You also need not
remove any Storage Window components other than one matching the one you
wish to install. The installation program will install your new Client Storage
and CLI Windows seamlessly under your existing Storage Window Manager.

Failover Mode Set in CLI

Client is intended to be used to configure and monitor your storage only, and
there are some functions available in the CLI that are not available in graphic
form in the GUI. If you wish to use your controller’s multiple-bus failover
mode, you must enable and control that function via the CLI.

In addition, if you wish to use virtual disk preferencing in multiple-bus
failover mode, you must set your virtual disk preferences via the CLI when
you set the failover mode.

Connection Limitations

Local SCSI or serial connections are only available with standalone Storage
Windows. You cannot use the Storage Window Manager to connect locally to
a subsystem.

Some Features Dependent Upon
Connection Type

Because of the nature of the connections you can use between Client and your
subsystems, the features available with each connection type vary slightly.
Some connection types impose limitations on Client’s features, as noted in
Table 5.
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Table 8
Feature Limitations

Feature

Connection

Type

Create virtual

disk

Delete virtual

disk

Fault Events:

Client Visual

Notification

Fault Events:

Paging

Notification

Windows 2000

Fault Events:

Event Logging

Email

Notification

(UNIX/VMS

only)

Local Serial

Connection

(Storage

Window

Manager and

Agent not

used)

Supported Supported Supported Not Supported Not Supported Not

Supported

Local SCSI

Bus

Connection

(Storage

Window

Manager and

Agent not

used)

Supported Supported Supported Not Supported Not Supported Not

Supported

Local Network

Connection

(Client and

Agent running

on the same

host)

Supported Supported Supported Supported Supported Supported

Remote

Network

Connection

(Client running

on a PC

remote from

Agent on a

host)

Supported Supported Supported Supported Supported Supported

continued
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Table 8
Feature Limitations continued

Feature

Connection

Type

Create virtual

disk

Delete virtual

disk

Fault Events:

Client Visual

Notification

Fault Events:

Paging

Notification

Windows 2000

Fault Events:

Event Logging

Email

Notification

(UNIX/VMS

only)

RAS

Connection

(Client running

on a remote

PC with a

dialup network

connection)

Supported but

not

recommended.

Follow-up

operating

system

configuration

cannot be

performed

remotely.

Supported but

not

recommended.

Follow-up

operating

system

configuration

cannot be

performed

remotely.

Supported

reliably only

while RAS

intact. Some

events may be

missed while

dialup

connection is

broken.

Supported

reliably only

while RAS

intact. Some

events may be

missed while

dialup

connection is

broken.

Supported

reliably at host

end only. Some

events may be

missed at Client

end while dialup

connection is

broken.

Supported

Delayed Event Notification on RAS
Connections

Visual fault notification, paging, and event logging may be delayed
significantly in situations where RAS connections are used for multiple
Clients. An Agent with multiple Clients in its client.ini file must poll each
Client whenever a fault occurs. Any Clients not currently network-connected
significantly delay this process, because Agent must wait for their connections
to time out before moving on to the other Clients.

To avoid this situation, set the notification_method parameter for each Client
in the client.ini file to “0”, to defeat event fault notification.

CLI RUN Commands

Do not issue RUN commands in the CLI Window. Use only a maintenance
terminal connection to issue RUN commands.

Creating Partition Units Across Targets
or Ports

Be aware that the name you pick for a unit assigns it to a particular host bus
target. If you create a unit from free space on a device, the program forces you
use a unit name that puts the unit on the same host target as the other partitions
on the device.
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On dual-port controllers, partitions on the same device that are assigned to
different host ports are not supported.

No Code Load in Multiple-Bus Failover
Mode

The controller code load feature is not functional in multiple bus failover mode
for non-OpenVMS network connections. Do not attempt to update your
controller’s software in this mode.

Maximum Members Dependent Upon
Virtual Disk Type

The maximum number of members allowed in a RAID-based virtual disk is
dependent on the disk type. However, concatenated sets are now available for
JBODs, stripes and RAID 3/5 sets.

■ JBOD virtual disks—maximum of one member. JBODs may now be
expanded to two disks if concatenated sets are used.

■ Striped virtual disks—maximum of 24 members

■ Mirrored virtual disks—maximum of 6 members

■ Striped mirrored virtual disks—maximum of 48 members

■ Parity virtual disks—maximum of 14 members

Maximum Number of Active
Connections Limited

The controller maintains a table of host port connections that can contain up to
64 named connections. Only 8 of those connections can be active (that is, “on
line”) at any time, however. Client shows only those connections that the
controller recognizes as “on line.”

Avoiding Problem Situations

In certain situations and under specific conditions, you may experience
unusual behavior with the software. This section presents information to help
you avoid such situations and to recover from them if they occur.

Enable Read-ahead Cache Before
Enabling Write-back Cache

The controller requires that read-ahead cache mode is enabled before you can
enable write-back cache mode.
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Incomplete Scans Cause Connection
Loss

For proper display of subsystem status, Client performs a “scan” to collect
information about your storage subsystems. The program displays scan
progress screens while the process occurs. In some, rare situations, you may
experience incomplete scans or scans that appear to hang. In these cases, the
likely cause is that Client has lost its connection with the virtual disk it was
using for communication with your subsystem.

This problem may show up with either local SCSI or network connections.

To remedy this situation, you must first restart both of your controllers,
followed by restarting Client and Agent. If the system still does not operate
properly, you must reboot your host system. If your host is running Windows
2000, you must ensure that the special device driver, HSZDISK.SYS, is
installed and running properly after it is booted.

Mirrored Cache Mode Not Retained
After Configuration Restore

If you restore your controller configuration from a configuration file, the
mirrored cache setting may not be properly enabled. You must restore the
mirrored cache setting manually, using a CLI Window.

Error Message on Exiting Storage
Window

Under certain conditions, when you exit a Storage Window, you may
experience an “Illegal Operation Error” message. You may ignore this
message.

Inappropriate Error Message on Device
Delete

If you select a disk, then chose Device/Delete, a dialog box may appear,
asking “Are you sure?”. If you choose the “NO” option, the message “Nothing
selected to delete!” is displayed. You may ignore this message.

Storage Window Corruption After
Making/Removing Spare Device

If you select a disk and make it a spare (using either menu or context menu
options), then remove the device as a spare, some information in the Storage
Window may be left corrupted. To reconstruct the window, you must exit the
window and open a new one.
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Cache Policy Not Shown in Controller
Properties Sheet

The controller cache policy may not be properly shown in the controller
properties sheet. The field may be blank. You must use a CLI Window to
obtain the cache policy setting.

Incorrect Capacity Shown in Add Virtual
Disk Wizard

In some circumstances, in Step 3 of the Add Virtual Disk Wizard, if you
specify a capacity greater than the available disk capacity, an error message
results. If you back up to Step 2 of the Wizard and return to Step 3, the correct
capacity is then displayed. An attempt to move to Step 4 of the Wizard at this
point, however, results in the same error message, even though the correct
capacity is shown.

To complete your virtual disk, you must exit the Wizard and attempt to
recreate the virtual disk.

Storage Window Corruption While
Deleting a Virtual Disk

In some circumstances, if you delete and confirm deletion of a RAID-based
virtual disk, a “Subsystem Connection Status” window may be displayed, and
the Storage Window goes blank. The Storage Window may remain blank for
several seconds until the  “Subsystem Connection Status” window disappears.

Application Errors When Restarting
Agent

You may experience an “application error” error when attempting to restart
Agent after manually changing the Agent configuration files. Either of the
following issues may be the cause:

■ The client.ini file must end with a carriage return. If any other character
terminates the file, it may cause an application error.

■ The storage.ini file must not end with a carriage return. If a carriage
return terminates the file, it may cause an application error.
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False Restart Message on Agent
Installation

When you first install a Windows 2000 Agent, and you modify more than one
configuration parameter, the installation program may prompt you with a
message indicating the Agent must be “restarted”, even though it has not yet
been completely installed. You may ignore this message, and you must
respond to the subsequent prompt, “Would you like to start the Agent service
now?” by answering “Yes.”

Client Access Changes Not In Effect

After manually editing or changing the Agent client.ini file with a configurator
program, you may notice that your Clients’ access has not changed. To place
your changes in effect, you must restart Agent after editing any of the Agent
configuration files.

Reconfiguration After Controller
Replacement

If you replace either of the controllers in your subsystem, you must
reconfigure your Agent storage.ini file to match the serial numbers of the new
hardware. See your Agent documentation for details on reconfiguring your
storage.ini file.

Storage Window Won’t Open

If you cannot open a Storage Window from the Storage Window Manager or
in standalone mode, the client.ini ACCESS_ALLOWED parameter for your
Client is probably set to “0”, disabling Storage Window access. Use the Agent
configuration script or edit the client.ini file to enable access to the subsystem.

Configuration File Deleted on Reinstallation
or Upgrade

Save a copy of the current swcc2.mdb file to another directory if you intend to
reinstall or upgrade Client. If you uninstall the program, you will delete the
swcc2.mdb file. This file contains your configuration of host systems and
storage subsystems used in the Navigation Tree.

To reinstate your current Navigation Tree configuration after installing a new
version of Command Console, copy your saved swcc2.mdb file back to the
directory to which you installed Command Console.
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Invalid Network Port Numbers During
Installation

During Client or Agent installation, you may experience an error if the
installation program cannot find an acceptable pair of network port numbers.

Your Client uses Windows sockets (sometimes called “network ports”) to
communicate with its Agents. The socket numbers at the Client and Agent
ends must match for network communication to occur.

In Windows 2000, the socket numbers are assigned in the services file in the
\winnt\system32\drivers\etc subdirectory. In UNIX-based systems, the socket
numbers are assigned in the services file in the /etc subdirectory. In the
unlikely event that you experience a conflict with the socket numbers, you
may edit the file manually.

There are two default socket numbers, one for Command Console (4998) and
the other for the HS series Client and Agent (4999). If you are installing either
Client or Agent and these numbers are already taken by another application,
the installation program prompts to warn you that you must choose another
pair.

To select another pair for Client, open the file containing the sockets in an
ASCII editor, after you have installed Client. Pick two numbers above 1023
that are not already used in the file, and add the following two lines:

spgui            number1/tcp # StorageWorks® Command Console
spagent          number2/tcp # StorageWorks® Command Console

NOTE:  The port numbers that you select must match the port numbers used by all of the
Clients to which you wish to connect your Agent.

Network Port Assignments for UNIX-
Client/Server Systems

A UNIX host may use Network Information Services (NIS) to serve the
services file containing its network port assignments.

Agent must use the services file to determine which network ports to use.
Because of this requirement, you may need to configure your system so that
Agent can access the proper services file.

You have two options to prevent a conflict between the two possible locations
of the services file. See the Agent user guide for your particular Agent for
more information.
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Error on First Attempt to Make
Connection

You may experience a system error such as a “Command Execution Error” on
your first attempt to make a network connection using the Storage Window. If
this happens, try the connection again, and it will succeed.

Client Hangs If Virtual Disk Deleted

If Client is monitoring a particular subsystem, and you delete the virtual disk
being used to communicate with that subsystem, the program may hang. To
delete the virtual disk Client is using for communications with an Agent, you
must first reassign another virtual disk as the communications LUN, using the
Agent configurator.

If you are using the CCL as your communications LUN, and you disable it,
Client may lose its connection with your subsystem. If you wish to disable the
communication LUN, you must first reassign another virtual disk as the
communications LUN.

Missing Tabs in Search Menu in Help

When you select the Search button in Command Console Help, Windows Help
may not display an Index or Find Tab.

To prevent this problem, delete any hidden files with a .GID extension that are
in the Command Console directory. The WinHelp engine uses .GID files to
construct the Index and Find Tabs. If the files are corrupted, the engine may
not display one or both of the tabs. Deleting the files causes the engine to
reconstruct the .GID files.

Invalid Cache Errors

Your controller module, cache module, and subsystem devices all contain
configuration information used to keep their activity synchronized. This data is
called metadata. The controller software reports an invalid cache error on the
affected controller in situations where there is a mismatch between the
metadata in the controller module and a cache module containing unwritten
data. This mismatch can result in loss of the unwritten cache data if the error is
not cleared properly.

CAUTION:  Use extreme care in responding to the Command Console invalid

cache error prompt. If you inappropriately instruct the program to delete
unwritten cache data, you may lose valid user data.
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Client displays a message and prompt box when an invalid cache error occurs.
You must tell the program whether to delete unwritten cache data as the error
is cleared. If you are not familiar with the proper treatment of unwritten cache
data, see the information in the online Help documentation under the topic
“Invalid Cache Errors.”

Connecting Via the Host SCSI Port

Client may indicate that it cannot find your subsystem if you attempt to
connect via the host SCSI port by using Windows 2000 in either of the
following situations:

■ A StorageWorks controller subsystem is connected to the host, but the
subsystem has no virtual disks configured on it in SCSI-2 mode with
CCL disabled.

■ A StorageWorks controller subsystem is not connected to the host.

 If you are using SCSI-2 mode and Windows 2000, you must disable the
Command Console LUN and create a virtual disk by using a serial
connection. For more information on the Command Console LUN, refer
to the Compaq StorageWorks Command Console V2.3 User Guide.

Note that because Agent uses a SCSI host bus connection to its subsystems,
the same rules mentioned above also apply.

Communications Failure on Power Up
with Low Batteries

If the battery in your cache is discharged when you power up the controller,
the controller may produce an invalid cache error. If you are using Client as
your controller interface at that time, the error may prevent communication
with the controller. In this case, the controller status bar in Client changes to
yellow, and the program displays a window containing error information.

To clear the error, you must exit Client and use a normal controller
maintenance terminal to issue the CLEAR ERRORS INVALID_CACHE
command before you can use the controller. See your controller
documentation for instructions on use of the CLEAR ERRORS
INVALID_CACHE command.

If the battery remains low, the invalid cache error may reappear. In this case,
you can operate your controller with reduced capability, or you can change its
cache policy to get around its built-in battery protection, although at some risk
to your data. Refer to your controller documentation for details on its cache
policy controls.
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After you have cleared the invalid cache error, you can use either a normal
maintenance terminal or Client as your controller interface.

Lost Connections Cause Invalid or
Missing Fault Displays and Event
Logging

Client receives notification for most types of changing subsystem fault
conditions on the next monitor interval after they occur. You may experience
invalid or lost notifications in situations in which Client’s connection with its
subsystems is broken. Any Windows 2000 event logs that might have occurred
while the connection was broken are also lost.

If the connection between Client and its subsystems is broken for any reason,
Client may continue to display faults that are cleared while the connection is
broken. Similarly, faults that occur while the connection is broken are not
displayed at all.

To avoid lost fault indications, make sure that Client’s connections with its
subsystems are monitored and maintained. To reestablish a connection with a
storage subsystem, you must exit and restart Client.

Broken connections can occur for a variety of reasons:

■ For RAS connections—It is the nature of a RAS connection that it is not
a full-time connection. Events that occur during a period, when the RAS
connection is not made, are not logged to Windows 2000's event logging
facility.

■ For serial controller connections—Bad or missing serial cable. To repair
this situation, plug in or replace the cable.

■ For host port SCSI connections—Bad or missing SCSI host cable, no
LUNs configured on controller on Client startup.

■ For network connections—Agent missing or not running, network
discontinuity, Agent not properly configured for your Clients.

■ THIS controller halted, reset or hung—To repair this situation, restart or
replace THIS controller.

■ The virtual disk being used for communications with the storage
subsystem is no longer available.



42  RA/MA8000, ESA/EMA12000 Fibre Solution Software V8.5C for Windows 2000 Datacenter Server Release Notes

No Agent Notification Causes Invalid or
Missing Fault Displays

For some types of faults, Agent does not send Client notification of changes in
status as they occur. Client displays whatever fault information it last received.
Following are three situations in which a fault can occur without immediate
display in Client:

■ The OTHER controller fails or is shut down.

■ A cache battery on either controller fails or goes low.

■ A cache module fails.

■ A fan fails.

■ A power supply fails.

In all of these cases, you can get status by viewing the subsystem in question
using the REFRESH option in the View menu.

Manual Restart Required in Some
Situations

In some situations in multiple-bus mode, both controllers must be restarted to
properly continue subsystem operation. Usually, this function is automatically
performed by the software. If only one controller in a dual-redundant pair
restarts, however, you must manually restart the other controller.

CCL Recognition

The Windows 2000 Agent will now recognize a CCL. The CCL cannot be
assigned a drive letter because it is a logical device and must be recognized by
its physical drive number. The Windows 2000 x86 Agents will recognize both
device names (a-z) and physical drive numbers. The disk administrator can be
used to find the associated drive number for any of the recognized devices.

Reservation Error Message

The Agent application, and other applications which access RAID storage
through SCSI, will get a reservation error if a device is reserved by one host
and another host attempts to access the same device. When this occurs, a
generic I/O error will be logged.
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Reservation Conflict

Agent will discard reserved LUNs from its list of devices to be statused. The
reservation conflict will be recorded for each reserved LUN in the system error
log. A notification will appear in the log for each LUN reserved. In addition to
the system’s binary error log (Tru64 UNIX), an error message will also be
recorded in the daemon.log file. An example of the error message is “Device
lunName is reserved and cannot be statused by steamd." This only applies to
Agent during its current run. If Agent is restarted without either a) releasing
the reservation or b) rescanning the bus, the reservation conflict will be
recorded again each time Agent is restarted.

For prior Agent releases, to avoid filling the binary error log, Agent must be
stopped and restarted with bus scan enabled. Agent will not record the
reserved LUN in the storage.ini file, and will not status the reserved LUN.

Multi-agent Functionality

With the current Agent and the direct SCSI connect Client, several Agents and
direct connect Clients can talk to the same controller. Only one will access the
controller at a time, with the others being blocked until the current request is
serviced. The multi-agent functionality will work with any controller with
ACS version 8.5+. This functionality is provided by the controller which the
Agent software takes advantage of.

Problems will still be encountered if running in a heterogeneous environment,
for example, running multiple agents or communicating with a combination of
HSZ70 and HSG80s. It is recommended that only one Agent be running in
such a heterogeneous configuration. The multi-agent functionality is not
available in the Novell Netware Agent.

Switching SCSI Modes

When switching HSG80 controllers from SCSI-3 to SCSI-2 mode, the host
system should be rebooted after the change is made. This will clear any
unclaimed SCSI-3 CCL devices from the system. Failure to clear devices can
cause erratic Agent behavior or crash the NT system (BSOD). It is also
recommended that you reboot when changing from SCSI-2 to SCSI-3 mode.
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Add Virtual Disk Wizard Cache
Functionality

The Add Virtual Disk Wizard allows you to try to add a unit that has
readahead cache enabled while read cache is disabled. This is an invalid
action. The controller will not allow the “add unit” to execute. The result is a
storageset without an attached unit. This “orphaned” storageset may be used to
create a new unit by returning to the Add Virtual Disk Wizard and adding a
unit of the same redundancy level as the failed unit.

Ensure that you do not check Enable readahead cache if Enable read cache is
unchecked. Refer to Step four of the Add Virtual Disk Wizard.

Add Virtual Disk Wizard – Partitioned
Units and Ports Functionality

The Add Virtual Disk Wizard allows you to choose a port when adding a unit
based upon a partitioned set that is different from the port of a current unit that
is using the same partition.

Ensure that you use a LUN ID that corresponds to units that have already been
used for a partitioned storageset. For example, if a unit using a partitioned set
has a LUN ID below 100 (for example, D55), then the subsequent units should
also be below 100. Likewise, if a LUN ID is 100 or above, subsequent LUN
IDs should also be above 100.

LUN ID is set on Step 4 of the Add Virtual Disk Wizard.

NT Agent CCL Access Device
Recognition

For ACS 8.5 in SCSI-3, it is possible to have multiple CCLs based on the unit
offsets. Agent picks the last of the set as the access device. The CCLs will not
appear in the disk administrator, but are visible in the registry with their port,
target, and LUN. The CCL will show as CCLp:b:t:I, each with a different
target number (port bus target LUN, for example, CCL2:1:1:0) in the
storage.ini file.

In SCSI-2, you will only get one CCL, which is presented as an offline device
in disk administrator. This CCL will show as “PhysicalDrive#” in the
storage.ini file.
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Host Non-descriptive Error Message

If the host machine running the Storage Window is not in the client.ini file of
an Agent and attempts to access that Agent, a non-descriptive error message is
returned. For example, “Cannot establish communication with ‘77FORD’ ”.
[Socket message is incorrect type.]

Multiple Connections in Controller
Properties Connections Tab

When paging through more than 8 connections in the Controller Properties
window Connections tab and then pressing the Previous button to return to
previous pages, some of the host id and adapter id labels may disappear. This
will not affect functionality.

Selecting Disk Drives When Creating
Snapshots

When creating a snapshot, if you select disk drives of different sizes, Storage
Windows reports the size erroneously. Storage Window adds all selected
devices together for selected capacity. The selected capacity is actually the
smallest drive multiplied by the quantity of drives selected. Storage Windows
will allow you to proceed when you have inadequate storage selected. When
you select drives of different sizes, you should calculate the selected storage
by multiplying the smallest drive by the quantity of drives selected. If you
select drives of the same size, this feature functions properly.

Client Domain Network Server (DNS)
Setup Application Error

You must ensure that your client DNS is set up correctly. In some situations,
Storage Window will get an application error if the Host of the Agent exists
but cannot be reached directly by the Client machine.

Expand Option Not Implemented

The Expand Unit option is not implemented in ACS version 8.5.

Agent Failure using Multiple Storage
Windows

If the Agent fails while you have multiple Storage Windows connected to
different subsystems, you may not be able to close the Storage Window. When
this occurs, close the Storage Window by using Windows Task Manager.
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Command Console Client Troubleshooting

Authorization Error when Adding the
Server to the SWCC Storage Window
Manager

If you receive an authorization error when you add an agent system to the
Storage Window Manager, your client system may be missing from the
Agent’s list of client system entries. If you have more than one type of Agent
installed on that agent system, the name of your client system must be on each
Agent’s list of client system entries.

Help Files Still Appear After Uninstall

After you have uninstalled a storage subsystem Client, its help files will still
appear. Delete the CCONSOLE.GID file, which may be hidden (Windows
Explorer > View > Options > View). This file will regenerate the next time
you use the Client's help files.

Authorization Error When Adding an
Agent System

If you receive an authorization error when you add an agent system to the
Navigation Tree, your client system may be missing from the Agent’s list of
client system entries. If you have more than one type of Agent installed on that
agent system, the name of your client system must be on each Agent’s list of
client system entries.

Increasing Screen Space for the Fabric
Windows and Storage Windows

Run the Client on a monitor that has a minimum super VGA (SVGA)
(800X600) display resolution. The Fabric Windows and Storage Windows
require a certain amount of screen space to properly display their contents.
When you use a VGA display resolution, screen space becomes more limited.
If you must use a VGA resolution, select the Auto Hide check box in the
Taskbar Properties window to increase screen space for the Fabric Windows
and Storage Windows.



  47

Invalid or Missing Fault Displays and
Event Logs

Invalid or lost notifications may occur when the client system’s connection
with a subsystem is broken. The client system receives notification for most
changing subsystem faults at monitored intervals. This means that if the client
system is no longer notified of subsystem faults, then changes to that
subsystem will not be displayed in the client system’s Navigation Tree,
Storage Window (if applicable), Fabric Window (if applicable), and Event
Viewer.

For example, while client system’s connection with a subsystem is broken,
you will not receive event logs pertaining to that subsystem, except to notify
you that the connection is severed.

The following list provides the reasons for broken connections. After you have
fixed the physical and/or software problem that is listed below, you will need
to close and reopen the Storage Window pertaining to that subsystem to obtain
its latest status.

■ RAS connections—Remote Access Service (RAS) connections are not
full time. When there is no RAS connection, events are not logged to the
Application Log of Event Viewer.

■ Serial controller connections—There may be a bad or missing serial
cable. To repair this situation, replace or plug in the cable.

■ Network connections—Agent may be missing or not running.

■ Network connections—There may be network discontinuity.

■ The Agent may not be properly configured for a client system.

■ If your setup includes a controller, the controller may have halted, reset
or hung. To repair the situation, restart or replace the controller.

■ If your setup includes virtual disks, the virtual disk being used for
communicating with the subsystem is no longer available.

Pager Notification Continues After
Exiting the Command Console Client

You may have noticed continuous pager notification in response to subsystem
faults, even though you have exited Command Console Client. This behavior
is normal.

AES runs under Windows 2000 as a service. It continues to run even after you
have exited Command Console Client. AES communicates with Agents, and it
activates paging when a subsystem event occurs.
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To stop pager notification, stop AES. For information on how to stop AES, see
Chapter 2, “About the Asynchronous Event Service,” in the SWCC User
Guide.

Some Graphics Do Not Scale Well with
Large Fonts

It is recommended that small fonts be displayed when using the SWCC Client
software on Windows 2000. Some of the graphics do not scale as well when
large fonts are used.

Starting Client from the Command
Prompt

To start the Client with network connections from the command prompt, enter
the following at the command prompt on the client system:

\path_to_client_directory\swcc.exe -d your_host_system your_host_subsystem

where -d your_host_system your_host_subsystem  is an optional set of
parameters that enables you to specify a system and a subsystem to start
Client, for example:

C:\>\Program Files\Compaq\SWCC\swcc.exe –d hostsystem subsystem

If you specify these parameters, Client opens with the system selected and the
subsystem displayed in the Storage Window, in the Fabric Window, or in a
Web browser. If Client is not already aware of the system and the subsystem,
it adds them to the Navigation Tree.

Troubleshooting Connection and Access
Problems

SWCC is a TCP/IP socket-based application. As a result, SWCC requires that
each node running a SWCC Client or Agent must have access to a valid hosts
file or Domain Name Service (DNS) server. The valid hosts file must include
at least the system itself and any other systems running a SWCC Client or
Agent that it will connect to.

Dynamic Internet Protocol Address
Allocation Not Supported

SWCC will not work properly if the client systems or agent systems are
obtaining an IP address dynamically. This is because the Dynamic Host
Configuration Protocol (DHCP) is not supported. RAS servers and IP
tunneling servers are supported only if they are configured to nondynamic IP
addresses.
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WINS Not Supported

Windows Internet Name Service (WINS) is a name resolution service
available for Windows 2000. SWCC does not support WINS. Each system,
using SWCC, must have access to either a DNS server or a valid hosts file.

Access Denied Problem

This section covers some of the most common reasons for a Client to receive
an "Access Denied" message when it attempts to add an agent system to the
Storage Window Manager.

Client System Not on Agent’s List

The client system is probably not on the authorized client system list for the
Agent. To verify that the client system is included, view the list of client
system entries in the Agent Configuration utility. For information on how to
add the client system to an Agent’s list of client system entries, please refer to
the User Guide.

Multiple Agents

If the agent system is running multiple SWCC Agents (for example, to support
different controller types) then the client system must be authorized for all
Agents. If the client system is missing from any authorized Client list of an
Agent, then that Agent cannot be added to the Storage Window Manager.

Aliases Not Checked

When SWCC Agents scan the Client authorization list, they do not check
aliases. The entry in the Client authorization list must match that returned by a
gethostbyaddr call in the hostent h_name field. SWCC will not scan the
hostent alias list to check if an alias may match the Client authorization list.

Entry in the Client Authorization List Does Not Match

Generally, the entry in the Client authorization list for an Agent must match
what gethostbyaddr(<client IP address>) will return in the hostent h_name
field when gethostbyaddr(<client IP address>) is executed on the Agent
system. If hosts files are not exactly the same on all systems, the h_name
returned may vary on different Agent systems, for example:

xxx.xxx.xxx.xxx client.somewhere.com client

will return client.somewhere.com in the h_name field, but:

xxx.xxx.xxx.xxx client client.somewhere.com

will return client in the h_name field.
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In some situations, you can configure the way a system uses DNS and its local
hosts file. Please refer to your system documentation to find how your system
is configured. Some systems may be configured to do the following:

■ Check its local hosts file first, then go to DNS.

■ Go to DNS first, then check its local hosts file.

■ Ignore DNS even if configured.

■ Ignore the local hosts file.

The best way to verify what needs to be used for a Client name in the Client
authorization list is to write a program that runs on the agent system and prints
the h_name field returned by gethostbyaddr(<client IP address>). Remember
the dynamic IP address allocation is not supported.

Adding New System by Using Internet Protocol Address May Cause
Client to Stop Responding

The SWCC Client may stop responding when you attempt to add a system by
using the agent system’s IP address rather than the agent system’s node name.
This occurs when the client system does not have a DNS server configured
that knows the agent system, and the agent system is not in the client system’s
hosts file. To correct this situation, add the agent system to the hosts file on the
client system.

If you receive an "Invalid host" or "Host not known" message when you
attempt to connect to an agent system, the solution is not to try the IP address.
Fix your DNS server configuration, or if that is correct, confirm that the DNS
server knows the agent system. If you are not using DNS, make sure the agent
system is in the client system hosts file.

Add New System by Using Internet
Protocol Address Crashes

The SWCC Client may crash when you attempt to add a system by using the
agent system’s Internet protocol (IP) address rather than the agent system’s
node name. This occurs when the client system does not have a DNS server
configured that knows the agent system, and the agent system is not in the
client system hosts file. To correct this situation, add the agent system to the
hosts file on the client system.

If you receive an "Invalid host" or "Host not known" message when you
attempt to connect to an agent system, the solution is not to try the IP address.
Fix your DNS server configuration, or if that is correct, confirm the DNS
server knows the agent system. If you are not using DNS, make sure the agent
system is in the client system hosts file. Remember, WINS is not supported by
SWCC.
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Running Message When Adding System
to the Storage Window Manager

When trying to add a new system to the Storage Window Manager, you may
receive a message, stating "No Agent running on specified system." This
message can appear for several reasons. The error most likely occurred as a
result of one of the following:

■ Wrong system name was entered.

■ Agents were not installed on the entered system.

■ Agents were installed on a system that stopped functioning.

■ The specific Client required to support the Agents, running on the agent
system, was not installed. For example, if the agent system only has a
Fibre Channel Interconnect Agent and the client system has only a
HSZ22 Client, the "No Agent Running" message will appear.

■ Port names and numbers in the services file may be missing or may not
match between Client and Agent. This may occur if the default value for
a SWCC port was already in use.

To check if Client support for an Agent had been installed, look at the
following registry key:

HKEY_LOCAL_MACHINE\Software\DigitalEquipmentCorporation\Command
Console\AppletManager

You should see a series of keys for supported products.

HSG80 Documentation Additions
and Corrections

HSG80 Array Controller ACS Version 8.5 CLI
Reference Manual Corrections

Following are the additions and corrections to the HSG80 documentation set:

CLI reference guide (EK-HSG85-RG.AO1/ 165145-001), page G-17: The
following sentence should be deleted: The controller supports a maximum of
eight units on each target.
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